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While Deltek has attempted to verify that the information in this document is accurate and 
complete, some typographical or technical errors may exist. The recipient of this document is 
solely responsible for all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is 
subject to change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are 
reserved. No part of this document may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, or translated into another language, without the prior written 
consent of Deltek, Inc. 

This edition published December 2014. 

© 2014 Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and 
proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related 
documentation, is provided for use only in accordance with the terms of the license agreement. 
Unauthorized reproduction or distribution of the program or any portion thereof could result in 
severe civil or criminal penalties. 

All trademarks are the property of their respective owners.  
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Using RiskBook for Risk Register Collaboration 
When you create risk events in Acumen, you may want others to review them and to provide 
input about the risk levels and impacts. You now have the option to publish your risk register and 
risk scoring matrix to RiskBook; an Acumen Add-on that uses Kona’s cloud-based social 
collaboration and productivity features.  

When you publish a risk register to RiskBook, Kona creates a space for that risk register. A new 
space is created for each risk register that you publish to RiskBook. All the risks that were in the 
risk register are published to the Kona space and can be viewed on the Risks tab. You can click 
on a risk and see a complete risk breakdown, including the values that the risk register owner 
entered for probability, as well as schedule and cost impacts.  

As the owner of the Kona space, you can invite people to the space to add comments and to 
share their opinions about the risks. For example, you may have listed a very high risk probability 
whereas others may feel the probability is a medium risk.  

In addition, you can use the other Kona tabs, such as the Conversations and Tasks tabs, to 
discuss the risks and to add tasks for others to complete. For example, you may add a task 
requiring each person in the space to add their own scores to the risk items. 

As with other Kona spaces, you have the option to set up space templates. For example, you 
may want to create a template that includes standard tasks relating to risk register. When you 
publish to RiskBook, you can select the template which Kona then uses when creating the space. 

After everyone has provided feedback, you can export the risk register to an XML file format 
which can then be imported back into Acumen. You can then compare your original risk register 
with the collaborative version and make any needed adjustments. 

 

The Acumen RiskBook license includes a Kona Business Account. 
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Software Requirements 
In order to use RiskBook, you will need a RiskBook license and one of the following browsers: 

 Internet Explorer 9 or higher 

 Google Chrome version 12 or higher 

 Safari 6.0 or higher 

 Firefox 9 or higher 
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The Kona Business Token 
The Kona Business Token includes three fields (Redirect URL, Client ID, and Client Secret) 
and is used to link Acumen to Kona. You will need this information if you need to manually enable 
RiskBook in Acumen (see next topic). 

 

You must be a Kona Business Account Administrator in order to obtain the Kona Business 
Token. 

To obtain the Kona Business Token, complete the following steps: 
1. From Kona, click Accounts in the left sidebar. 

2. Click the Account name. 

3. Click Edit Account in the upper right portion of the screen. 

4. Click the Integrations tab. 

5. If Acumen is listed, skip to step 8, otherwise continue with step 6. 

6. Click Add applications and complete the fields: 

 Application Name — Enter Acumen. 

 Redirect URL — Enter https://www.deltek.com. 

7. Click Done. 

The Acumen Client ID, Client Secret, and Redirect URL are listed on the tab.  

8. Copy and paste each field entry into the corresponding field in Acumen (File » Deltek 
Acumen Options » Platforms tab), or email the information to another user. 
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Enable RiskBook in Acumen 
When you purchase a RiskBook license, Acumen should automatically be set up to publish a risk 
register to RiskBook. If the Publish Risk Register to RiskBook icon on the S3 // Risk tab is 
grayed out, you may need to manually enable RiskBook. 

To manually enable RiskBook, complete the following steps: 

1. In Acumen, click  File » Deltek Acumen Options. 

2. On the Platforms tab, in the Kona by Deltek group, complete the following fields (this set 
of fields is known as the Kona Business Token): 

 Redirect URL 

 Client ID 

 Client Secret 

 

If you do not know the Kona Business token information that needs to be entered, 
please contact your Kona Business Administrator or Kona Support 
(support@kona.com), or you can log a case at: http://support.kona.com/tickets/new. 

3. Click OK to save the information and close the dialog box. 

 

 

mailto:support@kona.com
http://support.kona.com/tickets/new
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Publish a Risk Register to RiskBook 

 

In order to publish a risk register to RiskBook, you need to be a member of the Kona Business 
Account.  

If you do not have a Kona account, contact your administrator, or Kona Support 
at support@kona.com, to request that they add you to the Kona Business Account. An email 
will then be sent to you with details about setting up your account. 

To publish a risk register to RiskBook, complete the following steps: 
1. Select the S3 // Risk tab. 

2. In the Views menu, make sure that Risk Register is selected in the Left or Right panel. 

3. Use the risk register to create your risk events. 

If you enter an email in the risk register Owner Email column, and the user is a member 
of your Kona Business account, then when the risk register is published to RiskBook, the 
user will get an email inviting them to the space. 

 

See Risk Register in the Acumen User Guide for more information. 

4. In the Import / Publish menu, click the RiskBook down-arrow and select Publish 
Register to RiskBook. 

 

If this option is grayed out, see Enable RiskBook for more information. 

5. Do one of the following:  

 If you have set up a RiskBook space before, skip this step. 

 

If you have changed your password, you will need to re-authenticate by following 
the directions in Step 3 below.  

 If this is your first time setting up a RiskBook space, or if you have changed your 
password: 

a. On the Kona Log In screen, enter your Kona login details.  

 

If you are a Kona Business Account administrator logging into your 
account for the first time, click the question mark icon to display the reset 
password screen where you can set up your own password. 

mailto:support@kona.com
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b. Click Log In. 

c. On the Kona Integrate Risk Register screen, click Yes, Grant Access to 
allow Risk Register to access your Kona account. 

  

 

You only need to perform this login step the first time you access RiskBook or if 
you change your password. Acumen retains your Kona login information so that, 
when you create another RiskBook space, you won’t need to enter your login 
details or grant access to Kona again. 
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6. On the Create an Acumen RiskBook Register screen, complete the fields. 

 
 Space Name — Enter the name of your RiskBook space. 

 Description — Enter a description of the space. 

 Overview — Use this field to describe the purpose for the space. 

 Account — If you have more than one Kona account, select the account that Kona 
should use when creating the space. 

 Optional Template — If you have set up Kona templates, use this field to select a 
template to apply to the space. If this field is blank, then no template is applied. 

7. Click OK. 

8. Kona opens a browser window or a browser tab (depending on your browser settings) 
and creates the space. 
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9. The Risks tab lists all the risks from the published risk register. 
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Using RiskBook 
After you create the RiskBook space, you can invite people to the space to start conversations 
and get input on the risk register.  

Open a risk to:  

 View details about the risk register owner’s threat analysis score. 

 View or add comments. 

 View consensus results, including a breakdown for each category. 

 Add your own threat analysis scores. 

 View the risk matrix that the risk register owner set up. 

 

Example of a Risk Register in RiskBook 

 

View consensus 
results 

View risk matrix 

Add threat analysis 
scores 

Export risk register 
to XML file 
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Export Risk Register from RiskBook 
After everyone has provided feedback, you can export the risk register to an XML file. 

To export the risk register from RiskBook, complete the following steps: 
1. In RiskBook, click Export risk data. 

 

You must be in a specific space to export. You cannot export from My Kona as that is 
a cross space/project area. 

The export may take several minutes to complete. When complete, the number on 
your Kona notifications icon will increase by 1. 

The exported risk register is attached to the RiskBook space as a spreadsheet file. The 
file name is the same as the risk register Kona space name. 

2. Use the Files tab to open or download the file. 
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Import a Risk Register from RiskBook Into 
Acumen 
When you import a risk register from RiskBook into Acumen, you can import the owners values or 
the consensus values.  

The owner is the person who created the risk. The owner may not be the same person for all 
risks listed in a risk register. For example, Risk 1 may have been created by John and Risk 2 may 
have been created by Sam. The owner’s values are the values for probability schedule and cost 
impact that the owner entered for the risk. 

The consensus values are the average values of all the votes cast in RiskBook for probability 
schedule and cost impact for the selected risk register. 

 

See Import a Risk Register from RiskBook in the Risk Register section of the Acumen User 
Guide for more information. 

Use Acumen to Compare Owner and Consensus Values 
You can use risk comparison to compare what the owner thinks about the risks to what the rest of 
the team thinks. In order to do so, you must run risk analysis twice; once with the owner results 
and once with the consensus results. 

 

See Compare Owner and Consensus Results in the Risk Register section of the Acumen 
User Guide for more information. 
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Appendix A: Kona Business for the Administrator 

Getting Started  
My Kona is your personal view in Kona. It includes your: 

 Conversations 

 Tasks 

 Events 

 Reminder pad 

You can get back to this view anytime by clicking on the Kona logo in the top left hand corner. 

 

Kona Area Description 

 

Spaces lists all the spaces for which you are a member. 

A space is a private place where a group of people, with a common 
purpose or goal, can collaborate. 

 

People lists all the people with whom you are connected through 
Kona, both inside and outside your organization.  

To display certain people at the top of the list, click Manage then click 
the Favorite star next to their name. You can “favorite” up to 15 
people. 

 

The Kona Business Administrator uses Accounts to manage account 
users and client applications (integrations with Kona), and view usage 
reports. 
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Managing Accounts 

 

Accounts Area Description 

Members These are the people you have added to your Kona Business account. 

Administrators These are members who can add or remove people from your Kona 
Business account. In addition, they can see the names of all spaces; 
however, they can only see space details (for example, conversations) 
where they are included as a space member and have permissions to 
those space objects. 

Spaces These are all the spaces that have been created within your Kona 
Business Account. 

Space Publishers These are members who have been given the ability to create space 
templates. 

Get account reports These are usage reports that provide some visibility into which 
members and spaces are most active and who is most leveraging your 
Kona Business subscription. 
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The “Getting Started with Kona Business” Space 
This space is created for your initial Kona Business Admin and is designed to help you get started 
with your Kona Business subscription. 

 
The Tasks tab includes the following information:  

 Collateral to Share — This section includes a link to the Kona Business video, Kona 
overview slide deck, Common questions and more.  

 Best Practices — This section includes to-do’s such as subscribing to the business 
edition updates, tips on getting your first space going, and how to lead through this 
transition.   

 Kona Admin Checklist — This section outlines everything you need to get your 
organization up and running in Kona. 

Include Others in this Space 
Click Invite under Space Members in the right margin area of the space to add others involved in 
your Kona Business roll-out to this space. 
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